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Welcome

Welcome to the Authorware Working Model!

We at Macromedia are excited for you to experience the latest version 
of the most powerful authoring environment for interactive 
information. Authorware incorporates all the features you need to 
make the most of multimedia and to create just about any type of 
application you can imagine. You’ll find that multimedia authoring 
couldn’t be easier—or more fun. 

The enclosed Authorware Working Model contains a demonstration 
version of Authorware that you can use to start your explorations. This 
guide also contains a brief tutorial that lets you create your own 
Authorware piece using media we’ve included. This exercise highlights 
some of Authorware’s key features and lets you see for yourself how 
quick and easy it is to start creating.

We hope you enjoy using Authorware as much as we enjoyed 
developing it. To purchase Authorware, or to get further information, 
please contact Macromedia as noted at the end of this guide.

Thanks for taking a look at Authorware!

David Lasner
Director of Product Management
Macromedia
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Introducing Authorware

Authorware is the most powerful and complete authoring environment 
for creating and publishing interactive information. It was developed 
primarily to create learning, multimedia and other information-oriented 
applications that are content rich and highly interactive. Authorware 
provides everything you need to create:

• computer-based training applications

• educational courseware

• interactive reference publications

• kiosks

• CD-ROM magazines

• online documentation

• prototypes 

• simulations 

• hypermedia and hypertext applications

from Analysas Corporation’s Exito, an intensive Spanish-language 
course

from CO/OP Media, Video Producer, an interactive video 
production lab
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Icon-based Interface

To create an Authorware piece, you simply drag and drop icons onto a 
flowline that provides a visual outline of a file’s structure. This object-
oriented design method requires no programming or scripting, which 
increases an author’s productivity and makes pieces easy to maintain. 
The fifteen icons Authorware uses are intuitive and provide a range of 
powerful options. 

Once you’ve developed a basic structure using icons, you can run your 
piece and fill in content—such as graphics, text, digital movies and 
sounds—and control the on-screen action. Since you can look at a 
piece from a user’s perspective as you create it, it’s easy to insert and 
edit content on the fly and to try different ideas as you go. 

Interactivity

Authorware was built around the concept of interactivity. The more 
users interact with information, the more likely they are to retain it—
which is critical when you’re building any type of application meant to 
deliver information. 

Authorware provides the most complete set of tools available for 
designing, organizing and conveying interactive information. For 
example, built-in response types let you create pieces in which the 
user can interact with the information in a variety of ways. Buttons, 
text entry, hot areas, hot objects, movable objects, hypertext, dynamic 
searching, hot text styles, time-outs and many other options are 
available. Straightforward menus and dialog boxes make all of these 
options easy to implement even if you’re new to authoring. 

Multimedia Integration

Authorware provides easy-to-use tools that let you integrate text, 2D or 
3D graphics, digital or analog video, and sound into any piece. These 
multimedia elements add realism and immediacy to interactive 
applications and help ensure that you get your information across. 
Most industry-standard media formats are supported, and you can 
sequence, combine and edit these elements. 

• Video—Incorporate full-motion and still analog video with full 
control of frames and speed.
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• Digital movies—Import digital video sequences, including 
interactive Macromedia Director 4 and MPEG movies. You can 
easily integrate Director productions into Authorware pieces and 
use the movies interactively in Authorware. You can even send 
Lingo commands from Authorware to Director movies and receive 
information back from Director. 

• Sound—Use up to CD-quality, 16-bit, 44kHz digitized audio such as 
sound effects, music clips and voice-overs.

• Graphics and text—Import graphics or text files (including RTF) 
and apply special effects. Or use the object-based toolbox to create 
simple graphics and text. 

Hyperintelligent Authoring

Authorware contains complete hypermedia functionality, including 
hypertext. Dynamic search and retrieval of text and key words lets the 
user decide what to look for at run time. Ten different kinds of 
hyperlinks, including links to specific pages, previous and next links, 
first and last links, history links and custom links, make it easy for 
authors to structure pieces that do exactly what they want.

Default navigation schemes let you quickly browse through complex 
information. Using the many options available, you can create custom 
structures to support even the most intricate navigation requirements.

Reusable Content

Authorware’s libraries and models enable authors to store content so 
that it can be easily accessed by other authors.  

• Libraries allow you to store media such as sounds, graphics and 
movies in a central location. To use the content, all you do is open 
the library and drag the content icon into the file you’re working 
on. The Authorware file is linked to the library, so that if the 
content is edited in the library it will be automatically revised in all 
files that use the library. Libraries can be linked to many different 
files, and you can store them on file servers to make them available 
to all authors. Using libraries reduces file size and improves 
performance. 
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• Models let you create files that contain frequently-used Authorware 
interactions and icon logic. For example, you might create a model 
that contains a standard navigation structure you plan to use. You 
can then easily insert the model in other Authorware pieces and 
avoid having to recreate the logic each time. This allows you to use 
the same structure in an infinite number of ways and files.

Cross-Platform Compatibility

Authorware is one of the only authoring packages that lets you create 
and deliver interactive pieces equally well on both Windows and 
Macintosh systems. What’s more, you can create an Authorware file on 
either platform and easily convert it to the other platform. You can 
design pieces on one platform and deliver the same piece on both 
Windows and Macintosh. 

Variables and Functions

Authorware’s power is not limited to its icons. Hundreds of functions 
and variables are included with the product.  

• Variables provide extensive capabilities for collecting, storing, 
analyzing and displaying data. Authorware automatically tracks 
information such as whether the user clicked in a particular area 
and how many correct answers the user entered. This information 
can be stored in any standard database with Authorware ODBC 
drivers or edited and used in other Authorware pieces. 

• Functions provide additional tools you’ll find useful, such as the 
ability to read or write to external text files.

In addition to the variables and functions provided, Authorware lets 
you create your own variables and functions to track and store any 
type of information you need or to incorporate special features. 

Debugger

A customizable debugger allows you to track nearly every aspect of a 
piece to quickly locate problems in the design. The step functions and 
trace window provide easy ways of following a file’s logic.
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Extensible Architecture

Windows Dynamic Link Libraries (DLLs) and Macintosh External 
Commands (XCMDs) and External Functions (XFCNs) can be called 
from within Authorware when you need to incorporate unique 
capabilities. In Windows, Authorware’s expanded use of open 
architecture standards includes Open Database Connectivity (ODBC) 
drivers for standard database support (with models to help authors get 
started) and Dynamic Data Exchange (DDE) and Object Linking and 
Embedding 2.0 (OLE). As an OLE 2.0 client, Authorware allows 
developers to open any OLE server from within Authorware. 
Consequently, authors can deliver pieces from floppy disks, hard disks, 
CD-ROMs, and network file servers and jump to and return from other 
applications or files to share data.

Delivery

After you’ve developed an Authorware piece, you can save a runtime 
version of it which can then be distributed royalty-free to millions of 
users. Optimal media layout for CD-ROM performance is automatically 
managed by Authorware.

And More…

When you purchase Authorware, you receive extra materials to help 
your authoring project go even more smoothly. These include:

• Authorware Smart Clips and Macromedia ClipMedia: Thousands of 
professional-quality custom buttons, sliders, panels and bullets. You 
can run the browser that’s provided (created in Authorware, of 
course) to see what’s available and select your favorites, then 
import them directly into Authorware—complete with functioning 
logic.

• Comprehensive documentation. The Authorware user manuals 
provide guidance and answers to your questions. Complete online 
help is available, along with a Tips and Tricks guide that helps you 
with specific tasks.

• The Authorware Portfolio. You receive professional-quality models 
with complete descriptions and explanations. Paste these models 
into your files and edit them to meet your needs.
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About the Authorware Working Model

The Authorware Working Model contains the tools you need to get 
started with Authorware. These tools include:

• ReadMe file—contains installation instructions for the Working 
Model software and other information.

• Authorware Working Model installer program—The Authorware 
Working Model is a demonstration version of the Authorware 
software. It contains all the features you’ll get when you buy your 
software, except that you can create pieces containing only up to 
50 icons. This means that the Working Model lets you create small 
samples while the full product lets you create Authorware pieces as 
large as you need.

• QuikTour folder—contains the files you need to complete the Try 
This exercise described in this guide.

• Misc folder—contains additional files that may be necessary to run 
the Authorware Working Model, such as Video for Windows or 
Macintosh QuickTime.
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Installation

The Authorware Working Model installation program will quickly 
install the Working Model and its associated drivers. For more 
information on installation, open the ReadMe file. 

Note: You must have Video for Windows or Macintosh QuickTime 
installed in order to run the Working Model. They’re provided in the 
Misc folder if you need to install them.

The table below lists the hardware and software requirements for the 
Working Model. Authoring requirements for the Authorware software 
and the Working Model software are the same. 

Note: Before installing Authorware for Windows, you must install all 
Windows files using the Windows setup procedure. Run Windows in 
either standard or enhanced mode. If you run Windows in enhanced 
mode, we recommend that you set up a permanent swap area to 
enhance performance. For more information, refer to the 
documentation that comes with Microsoft Windows.

Requirements Windows Macintosh

Computer 33 MHz with an Intel 80486 
processor

25 MHz with a 68030 processor 
(Macintosh IIci, for example)

System software Microsoft Windows 3.1 System 7.x

Memory 8 megabytes 8 megabytes

Display VGA monitor with 16 or more 
colors

640 x 480 color monitor

Hard Disk Space 40 megabytes 40 megabytes

CD Drive Double speed Double speed

Sound Sound card if you want to play 
sounds
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You’re probably eager to try creating 
something in Authorware for yourself. This 
example shows you just a subset of 
Authorware’s powerful features and how easy 
they are to use. 

We’ve created an Authorware file that is the 
start of a larger piece. Imagine that you’re part 
of a team working on a large kiosk 
application that will let users interact with 
various types of information. In this exercise, 
you’ll use content we’ve already set up to 
build your part of the larger piece. All the 
elements you need for this example are 
located in the QuikTour folder.

Before you start this exercise, you’ll want to 
preview what you’re going to create. To do 
this, open the complete.a3w (Windows) or 
complete.a3m (Macintosh) file. Select the Run 
button from the toolbar or choose Run from 
the Try It menu.

This example leads you through the following 
sections in creating the piece:

• Open an Authorware File

• Authorware Basics

• Import a Sound

• Link Media From a Library

• Move a Graphic

• Create a Framework

• Import an RTF File

• Import a Director Movie

• Import Graphics

• Create Hypertext (optional)

• Create an Interaction With a Custom 
Button

• Paste Models

• Finish the Piece

Try This!
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Open an Authorware File

To begin, you need to open the Authorware 
file we’ve started for you. You may want to 
take a minute to look at the basic elements of 
Authorware’s interface, which are shown on 
the next page and in the Welcome file.

1. Start Authorware by double-clicking the 
Authorware 3 icon in the Windows 
Program Manager or on the Macintosh 
Desktop. 

A file dialog box appears. 

2. In the QuikTour folder, select the start.a3w 
file and click OK (Windows) or select 
start.a3m and click Open (Macintosh).

An Authorware file is displayed. The 
illustration on the next page shows the 
main components of the Authorware 
screen. The only item in your file so far is 
a display icon called Main Background 
that we’ve inserted for you.  

3. Choose Save As in the File menu. Select a 
drive, type a filename such as mystart.a3w 
or mystart.a3m and click OK (Windows) or 
Save (Macintosh). 

4. Click the Run button in the toolbar. 

When you run your file, Authorware 
presents it on the screen just as a user will 
see it. This allows you to check your work 
in progress and to make changes on the 
fly. Right now, you have only one icon in 
the design window, so Authorware opens 
that icon and displays its contents.  

The Main Background display icon 
contains a background graphic and some 
buttons that currently aren’t functional. 
Looking at this icon’s content will help 
you see how the piece you’re going to 
create is meant to fit into a larger appli-
cation. Note that there are buttons on both 
sides of the graphic that allow users to 
access various information. You are going 
to create content that will appear when 
users select the Shopping Areas button.

5. Press Control-J (Windows) or Command-J 
(Macintosh).

These are the keyboard shortcuts for the 
Jump to Icons command. This command 
lets you stop running the file and return to 
the design window where the icons are 
displayed.
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Authorware Basics 

Flowline

Design window

Icon palette

Help

Display—displays graphics and text you create or 
import using a variety of special effects.  

Motion—moves on-screen text, graphics and digital 
movies from one point to another over a given amount of 
time or at a specified speed. Erase—removes text, graphics, animations and digital 

movies from the screen using a variety of special 
effects.Wait—pauses the application until the user clicks a 

button, presses a key or times out.
Navigate—goes to the destination icon you specify. 
Provides ten different hyperlinks for navigating within a 
file.Framework—provides an easy way to create navigation 

structures. The icons you attach to the framework act like 
pages in a multimedia book. Decision—determines which path to follow based on 

author-defined controls, such as conditional branching.
Interaction—determines which path to follow based on 
the user’s response. Provides many response types 
including custom buttons, hot spots and pull-down menus. Calculation—performs functions, manipulates 

variables, calls external routines and jumps to other files 
or programs.Map—places selected icons in a new window with its 

own flowline. Use maps to organize and modularize your 
file. Digital Movie—plays back imported digital video 

sequences, including QuickTime, Video for Windows, 
MPEG and interactive Macromedia Director movies.Sound—plays imported digitized audio such as sound 

effects, music clips and voice-overs.
Video—plays full-motion and still analog video 
sequences using a variety of controls.

Start and Stop flags—let you run any part of a file while 
authoring. Place these flags on the flowline to indicate 
where to start and stop running the file.

Toolbar

Color—assigns color to selected icons to easily identify 
and organize logic, which facilitates team authoring.

Run button—changes to
Run from Flag (       ) when 
start flag is placed on flowline
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Import a Sound

Authorware lets you use sounds in a variety 
of ways throughout a piece. For example, you 
can set up sounds to play while certain items 
are appearing on the screen or play a sound 
when the user clicks a button. 

1. Drag a sound icon from the palette and 
drop it below the Main Background display 
icon. Title the icon “Travel Music”. 

To title an icon, just click the icon and 
type.  

2. Double-click the sound icon to open it and 
select a sound from the QuikTour folder.

• On a Windows system, a Load Sound 
dialog box appears. Choose the 
travel.wav file and click OK.

• On the Macintosh, click the Load 
button to display the Load Sound 
dialog box. Choose the travel.aif file 
and click Open.

An options dialog box for the Travel Music 
icon is displayed.  

3. Click the Play button to try out the sound 
you loaded. Click the Stop button to stop 
the sound.

4. Click the list box in the top left corner of 
the dialog box. (Wait Until Done is 
currently displayed.) Select Concurrent.

Choosing this option sets up the sound to 
play while other icons you’ll insert later 
are presented.  

5. Click OK to close the dialog box.  

Play Stop
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Link Media From a Library

Libraries are one of the many Authorware 
features that enhance your efficiency as a 
multimedia author. You can easily create 
libraries of icons that contain graphics, 
sounds, movies and text. The content is 
stored in a library file; by editing the content 
in the library file, you quickly update the 
content in all files that use the library. This 
provides a simple way of ensuring that 
content is standardized among all the authors 
working on a project and that content is 
updated when needed without manually 
changing it in every file. 

1. Choose Open Library from the Libraries 
menu. In the Open Library dialog box, 
choose the merchnt.apl library and click 
OK (Windows) or Open (Macintosh).  

A library window appears with two icons 
listed. If you want, you can select a library 
icon and choose Get Info from the Edit 
Menu to see what it contains.  

2. Drag the Travel Background display icon 
from the library window and drop it below 
the Travel Music sound icon in your design 
window.  

Notice that after you insert the library icon 
and click elsewhere, the icon’s title is 
italicized. This indicates that the icon is 
linked to a library.  

3. Drag the Travel Logo display icon from the 
library window and drop it below the 
Travel Background icon in your design 
window.  

Your flowline now looks like the one 
shown below. So far, you’ve placed a 
sound and some graphics—now let’s put 
them to work.

4. Click the Run button in the toolbar.

Authorware presents the icons you’ve 
inserted in order. You see the main 
background, hear the sound begin playing 
and see the travel background and logo 
you pasted from the library.

5. Press Control-J (Windows) or Command-J 
(Macintosh).

You return to the design window.

6. Save your file.

Press Control-S (Windows) or Command-S 
(Macintosh) or choose Save from the File 
menu.
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Move a Graphic

You’ll often want to put objects in motion on 
the screen to create special effects or to 
illustrate how something works. Authorware’s 
motion icon lets you move text or graphics in 
just about any way you can imagine. 

1. Drag a motion icon from the palette and 
drop it below the Travel Logo icon. Title 
the motion icon “Move Logo”. 

The motion icon allows you to control an 
object’s movement on the screen. The 
motion icon is placed after the object you 
want to move.

2. Drag the start flag from the palette and 
place it above the Travel Music sound icon. 

The start and stop flags allow you to run 
just a part of your file, such as the part 
you’re currently working on. When you 
place the start flag and run the file from 
flag, Authorware begins presenting the 
icon directly below the start flag. 

3. Click the Run from Flag button in the 
toolbar. 

When you place the start flag on the 
flowline, the Run button changes to a Run 
from Flag button. The motion icon options 
dialog box opens. 

4. Drag the logo to the center of the top line 
of the box in the background. 

By dragging the logo, you are indicating 
where you want the logo to be moved 
when the file is run.  

5. In the dialog box, click the Speed button. 
Type .5 in the Rate field. 

Choosing these options means that the 
logo’s movement from its starting position 
to its ending position will take .5 seconds. 

6. Click the Replay button to view the 
movement.

The logo moves from its original position 
to its new position in the center of the line 
at the top of the box.  

7. Click OK to close the dialog box. Press 
Control-F (Windows) or Command-F 
(Macintosh) to run from flag again and see 
the animation and hear the sound you’ve 
inserted.  



14 Create a Framework

Create a Framework

Authorware’s framework icon lets you 
automatically provide a simple way for users 
to move to different areas of your piece. After 
you insert a framework icon, you attach other 
icons to it. As you attach icons, Authorware 
automatically sets up buttons the user can 
click to navigate through the content. Here 
you’ll use some of the framework icon’s basic 
capabilities, but keep in mind that both the 
framework and navigate icons contain a 
variety of options that enable you to build 
intricate navigation schemes—without 
programming!

In this example, the framework icon will 
allow you to quickly set up a means for the 
user to navigate through the pages in an RTF 
file you’ll import in the next section.  

1. Press Control-J (Windows) or Command-J 
(Macintosh).

You return to the icon display in the 
design window.  

2. Drag a framework icon from the palette 
and drop it below the Move Logo motion 
icon.  

3. Drag a display icon from the palette and 
drop it to the right of the framework icon.

When you drop a display icon in place, a 
connecting line is drawn between the 
framework and display icon (see below). 
This indicates that, when you run the file, 
Authorware will present the display icon’s 
contents when it encounters the frame-
work icon. The framework icon itself will 
control how users can move among the 
icons you attach to it, as you’ll see later.

4. Click the framework icon and title it 
“Locations”. Press Enter (Windows) or 
(Return) Macintosh and title the display 
icon “Travel Intro”.

 The flowline will now look like this:  

5. Click the Run from Flag button in the 
toolbar.  

Authorware runs the file and stops at the 
Travel Intro icon to allow you to insert 
content. The graphics toolbox appears. 

Authorware automatically inserted the left 
and right arrow buttons and the Go To 
Merchants button as part of the framework 
icon. This is a default navigation structure 
that we’ve set up for you, and you can 
easily customize the framework and set up 
buttons that will take the user anywhere in 
the piece.
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Import an RTF File

Authorware lets you import text that has been 
saved in rich text format (RTF) in another appli–
cation. You can then edit and format the text as 
you like within Authorware. For this example, we 
created an RTF file in a word processing program 
and divided it into four pages with page breaks. 
When you import an RTF file, you can maintain 
page breaks from that file. Each time it encoun–
ters a page break, Authorware inserts a new 
display icon that contains a page of the imported 
text. (You can even automatically set up the text 
to appear in a resizable scrolling window.) 

1. Select the text tool in the toolbox (the 
letter “A”). Click about an inch to the right 
of the “L” in the Travel logo. 

2. In the text width bar that appears, click the 
adjustment handle (the square) on the 
right side and drag it to the left just inside 
the border.

This defines the area in which the text you’ll 
import will fit.

3. Choose Import from the File menu. Select 
the travel.rtf file and choose Paste.  

An RTF Import options dialog box appears.  

4. Open the Modes palette in the Attributes 
menu. Select Transparent.

5. Click OK to use the default RTF options. 

The text is pasted. 

6. Click the close box in the upper left corner 
of the toolbox. Click the left and right 
arrow buttons to move through the pages. 

7. Press Control-J (Windows) or Command-J 
(Macintosh) to return to the design 
window.

Notice that Authorware added three display 
icons to the Locations framework. The first 
page of the text from the RTF file has been 
placed in the Travel Intro icon, and the 
remaining three pages have been placed in the 
page 2 through 4 icons. 

8. Title the new page icons “Caribbean”, 
“Europe” and “South America”. 

9. Press Control-S (Windows) or Command-S 
(Macintosh) to save your file. 
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Import a Director Movie

Authorware lets you easily import digital video 
sequences to enhance your pieces and emphasize 
the points you’re trying to get across. Here you’ll 
import an interactive Macromedia Director 
movie.

1. Click the Caribbean icon and choose Group 
from the Edit menu.  

This creates a map icon that contains the 
Caribbean display icon. Map icons let you 
group other icons into their own design 
windows. This allows you to streamline your 
main design window and keep related icons 
together. We create a map here because we 
want multiple items—text and a digital 
movie—for the Caribbean location. 

2. Double-click the Caribbean map icon to 
open it. Drag a digital movie icon from the 
palette and drop it below the Caribbean 
display icon.

When you open the map icon, a design 
window titled “Caribbean” appears. The 
Caribbean display icon you previously 
inserted appears in the window. 

3. Title the new icon “Caribbean Movie” and 
close the map window.

Close the map window by double-clicking the 
Control menu box (Windows) or clicking the 
close box (Macintosh).

4. Click the Run from Flag button in the 
toolbar, then click the right arrow button 
on the screen.

The Load Movie dialog box appears. Because 
you inserted a digital movie icon without any 
content, Authorware pauses to let you load the 
movie. 

5. Choose the dive.dir movie and click Load 
(Windows) or Open (Macintosh). Uncheck 
“Use Movie Palette” on Windows.

6. Drag the Caribbean Movie dialog box to 
the side. Drag the movie and align it with 
the background frame. 

7. Click OK in the dialog box.

Try clicking the arrow buttons on the movie 
display to view the interactive Director 
movie.

8. If necessary, resize and reposition the text 
to fit in the background area next to the 
movie.

Double-click the text to select it. To move the 
text, click and drag it. To resize the text area, 
drag one of the handles that appear around it.
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Import Graphics

You can insert graphics into Authorware that 
were created in most standard formats and 
display them using a variety of special effects. 

1. Close the toolbox if it’s open. Click the 
right arrow button.  Double-click the “Trek 
Across Europe” text that appears.  

This brings up the toolbox for the Europe 
page in the framework.

2. Choose Import from the File menu. Select 
the europe.bmp (Windows) or europe.pct 
(Macintosh) file and choose Paste.  

3. Select Matted from the Modes palette 
shown at right.

This is so the graphic will appear opaque 
with a transparent matted background.  (If 
the Modes palette isn’t on the screen, 
choose Modes from the Attributes menu.) 

4. If necessary, resize and reposition the text 
and graphic to fit in the background area, 
as shown below. 

To move the graphic or text, click it and 
drag it to a new position. To resize the text 
area, click the text and drag one of the 
handles that appear around it.  

5. Close the toolbox and click the right arrow 
button. Double-click the “South America” 
text that appears. Repeat steps 2, 3 and 4, 
importing the samerica.bmp (Windows) or 
samerica.pct (Macintosh) file.   

6. Close the toolbox and click the right arrow 
button. Double-click the “New Tours” text 
that appears. Repeat steps 2, 3 and 4, 
importing the travel.bmp (Windows) or the 
travel.pct (Macintosh) file.

This is the introductory screen for the 
travel information the user will be able to 
access.  

Modes palette
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Create Hypertext (optional)

The ability to create text that users can click 
to move to other areas in your presentation is 
one of the easiest-to-use features in 
Authorware. You can make any piece of text 
clickable and add features to let users know 
where the hot areas are. Here you’ll enable 
the user to click one of the three travel 
locations (Caribbean, Europe or South 
America) and see the page containing 
information about that location.

1. In the Travel Intro display, choose the text 
tool (the letter “A”) and double-click the 
word Caribbean.

2. Choose Apply Styles from the Text menu. 
In the window that appears, choose 
Hypertext.  

Choosing Apply Styles displays a window 
listing the names of all text styles 
previously created using the Define Styles 
command, as shown above. We’ve already 
created a style called Hypertext that you 
can apply to your text. (Look at the 
options set up for the Hypertext style by 
choosing the Define Styles command from 
the Text menu.) The Hypertext style 
automatically changes the text’s color and 
makes it clickable. It also uses a custom 
cursor (the hand).

After you choose Hypertext, the Navigate 
To dialog box appears. 

3. In the list box on the right side of the 
dialog box, select the Caribbean icon and 
click OK.

You are choosing what will happen when 
the user clicks the word Caribbean. 
Because you’ve selected the Caribbean 
icon, Authorware will display the icons in 
the Caribbean map whenever the user 
clicks the word Caribbean.

4. Select the word Europe and choose 
Hypertext. Click Europe in the icon list and 
click OK.

Authorware will present the Europe 
display icon whenever the user clicks the 
word Europe.

5. Select the words South America and 
choose Hypertext. Click South America in 
the icon list and click OK.

6. Press Control-P (Windows) or Command-P 
(Macintosh) to continue running the file. 
Click the word Caribbean.  

The text and movie you inserted earlier 
appear.  
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Create an Interaction With a Custom Button

Interactions are at the heart of Authorware: 
they provide a way for users to interact with 
your piece—for instance, by clicking buttons 
or objects or pulling down menus. When 
Authorware encounters an interaction on the 
flowline, it waits for the user to respond. 

1. Press Control-J (Windows) or Command-J 
(Macintosh) to jump to the design 
window. Remove the start flag from the 
flowline by clicking its empty place on the 
palette.

2. Select all icons except the Main 
Background icon and choose Group from 
the Edit menu. Title the new map icon 
“Travel”.

To select multiple icons, hold down the 
Shift key and click them. Grouping the 
icons inserts them in a new map icon that 
contains all of the travel-related content. 
This helps to modularize and organize 
your file. 

3. Drag an interaction icon from the palette 
and drop it below the Travel icon. Title the 
icon “Merchants”. 

4. Drag the Travel icon to the right of the 
Merchants icon. In the dialog box that 
appears, click OK. 

When you attach an icon to an interaction, 
the Response Type dialog box lets you 
choose how the user can respond to the 
interaction. In this case, you’ll let the user 
choose this response by clicking a button. 
If the user clicks the button associated 
with the Travel icon, Authorware presents 
the icons in the Travel map. 

5. Double-click the response type symbol for 
the Travel icon. 

The Button Options dialog box appears. 
Here, you can select which button will be 
used for the Travel icon and how the 
Travel icon’s content will be handled. 

Response type symbol
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6. In the Erase Feedback list box in the lower 
right corner of the dialog box, choose 
Before Next Entry. 

This is so the contents of the Travel map 
icon will be removed from the screen 
before the user selects another button.

7. Click the Travel button under the Button 
Type options in the dialog box.

The Button Library window appears. The 
library contains the default buttons that 
Authorware provides plus some custom 
buttons that we’ve imported for you. 

8. Scroll the list to display the Travel button 
shown below. Click the button and click 
OK. Click OK again to exit the Button 
Options dialog box. 

9. Click the Run button in the toolbar.

Authorware encounters the interaction and 
waits for you to respond.

10. Click the Travel button you inserted.

Clicking this button matches the 
interaction’s attached button response, 
displaying the Travel map icon’s contents.

11. Press Control-J (Windows) or Command-J 
(Macintosh) to return to the design 
window.

Now you’ve created an interaction and 
provided the user with a button to click. 
Next, you’ll add some other choices for 
the user and then try out your creation. 
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Paste Models

Models are special files containing icons that 
can be quickly pasted into a file. Models let 
authors create templates and share logic 
structures and content.

1. Choose Load Model from the Libraries 
menu, select the paris.mod file and click 
Load (Windows) or Open (Macintosh).

This loads the model into Authorware so it 
is available for pasting.

2. Choose Load Model from the Libraries 
menu again, select the pacsands.mod file 
and click Load (Windows) or Open 
(Macintosh). 

3. Click to the right of the Travel icon so the 
paste hand appears. Choose Paste Model 
from the Libraries menu and select the 
Cafe Paris model.

The icon stored in the model file is pasted 
into your design window. 

4. Choose Paste Model from the Libraries 
menu again and select the Pacific Sands 
model. (If the paste hand doesn’t appear to 
the right of the Cafe Paris map icon, click 
next to the right of this icon before pasting 
the model.)

The window now contains an interaction 
icon with three attached map icons. 
Because you set up the Travel icon as a 
button response, the two new icons are 
automatically set up with button response 
types. (You could change this if you 
wanted.) When we created the two 
models, we saved them with custom 
buttons, so you don’t need to select 
buttons for them as you did for the Travel 
icon. This interaction will provide your 
file’s main structure. 

5. Press Control-S (Windows) or Command-S 
(Macintosh) to save the file. 
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Finish the Piece

1. Press Control-R (Windows) or Command-R 
(Macintosh) to run the file.

Authorware displays the Main Background 
graphic, then encounters the Merchants 
interaction. Three buttons representing the 
map icons attached to the Merchants 
interaction are displayed on the screen. 

2. Pause the application by pressing Control-P 
(Windows) or Command-P (Macintosh). 
Drag the Travel button and align it with the 
Cafe Paris and Pacific Sands buttons as 
shown below. Press Control-P or 
Command-P to proceed running the file.

3. Click the Cafe Paris button. Try clicking the 
arrow buttons to move between pages. 
Then click the Go To Merchants button.  

Clicking the Go To Merchants button lets 
you exit the Cafe Paris area and return to 
the screen with the three option buttons. 

4. Click the Travel button.  

Try out the hypertext (if you created it) 
and click the arrow buttons. As in the Cafe 
Paris screen, the Go To Merchants button 
lets you return to the screen with the three 
button options. The Go To Merchants 
button was automatically set up in the 
framework icon you inserted earlier—it 
provides a way for the user to exit the 
framework structure.

5. To close the file, press Control-Q 
(Windows) or Command-Q (Macintosh).

You’ve now created and edited a basic 
Authorware piece. Of course, if you were 
creating the complete Electronic City Hall, 
you’d insert this Merchants interaction within 
a larger structure. But you now have the 
basics down and are ready to start creating in 
Authorware.
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Purchasing Authorware

We hope that this Working Model has clearly demonstrated the power 
and versatility of Authorware. Authorware has been the leading 
authoring tool since it was introduced, and it remains the tool of 
choice for developing interactive multimedia applications.

When you purchase Authorware, you receive both the authoring 
software and the runtime software that lets you deliver pieces in a 
format appropriate for users. We also include the drivers and file 
importers you need for using multimedia elements, along with sample 
movies, sounds and graphics that you can load and use.

Authorware is developed by Macromedia, the leading producer of 
multimedia software. Macromedia does not charge royalties for the sale 
or distribution of runtime applications created with Authorware. 

The commercial version of Authorware is available in the United States 
through value-added resellers (VARs). The educational version of 
Authorware is available in the United States through educational 
resellers. For the name of a VAR or educational reseller in your area, 
call (800) 288-4797.

• Macromedia, Inc. (US, Canada, Pacific and Latin America)
600 Townsend Street
San Francisco, CA 94103 
USA
Tel (415) 252-2000
Fax (415) 626-0554

• Macromedia Europe (includes Middle East and Africa)
4 Wellington Business Park
Dukes Ride
Crowthorne, Berkshire
RG45 6LS England 
UK
Tel +44 1 34 476 1111
Fax +44 1 34 476 1149
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• Macromedia Japan
Seron Building 3F
Shinsen-Cho 11-7
Shibuya-Ku
Tokyo 150 
Japan
Tel +81 3 3462 5790
Fax +81 3 3462 5794

• Macromedia East Asia and Pacific
9 Minto Street
East Kew, Victoria Australia 3102
Tel +61 3 859 8325
Fax +61 3 859 4162


